A User’s Guide to GAETR: Sandia’s “Graphical Analysis of Event Trees” Software

Prepared by
Sandia National Laboratories
Albuquerque, New Mexico  87185 and Livermore, California  94550

Sandia is a multiprogram laboratory operated by Sandia Corporation, a Lockheed Martin Company, for the United States Department of Energy under Contract DE-AC04-94AL85000.

Approved for public release; distribution is unlimited.
A User's Guide to GAETR:
Sandia's "Graphical Analysis of Event Trees" Software

K.M. Hays
Risk Assessment and Systems Modeling Department
Sandia National Laboratories
PO Box 5800
Albuquerque, NM 87185-0747

Abstract

This document is a reference guide for GAETR, Graphical Analysis of Event Trees, a software package developed at Sandia National Laboratories. GAETR may be used as a stand-alone code or as a module in the ARRAMIS™ risk and reliability code suite. GAETR is designed to graphically create event trees and plot SETAC (Sandia Event Tree Analysis Code) output on IBM-compatible personal computers using the Microsoft® Windows™ 95/NT operating environment. This manual explains the fundamentals of creating an event tree, including formatting, saving sequence information, printing, editing, and importing graphics to other software packages.
CONTENTS

1 INTRODUCTION ................................................................................................................................. 1

2 INSTALLATION INSTRUCTIONS ............................................................................................................. 2
  2.1 MACHINE REQUIREMENTS .................................................................................................................. 2
  2.2 INSTALLING GAETR ........................................................................................................................... 2
  2.3 TROUBLESHOOTING ........................................................................................................................... 3

3 OVERVIEW OF GAETR ............................................................................................................................ 4
  3.1 THE MAIN SCREEN IN GAETR ............................................................................................................ 4
    3.1.1 GAETR Toolbar ............................................................................................................................... 5
    3.1.2 Edit Bar ........................................................................................................................................ 5
    3.1.3 Status Bar ..................................................................................................................................... 6
    3.1.4 GAETR Menus ................................................................................................................................ 6
  3.2 TREE WINDOWS .................................................................................................................................. 7
    3.2.1 Questions ...................................................................................................................................... 7
    3.2.2 Branches ...................................................................................................................................... 7
    3.2.3 Tables .......................................................................................................................................... 7
    3.2.4 Notes .......................................................................................................................................... 8
    3.2.5 Current Selection ........................................................................................................................... 8
    3.2.6 Pop-Up Menus ............................................................................................................................. 8

4 FILE HANDLING ..................................................................................................................................... 9
  4.1 CREATING A NEW FILE ...................................................................................................................... 9
  4.2 OPENING A TREE FILE ....................................................................................................................... 9
  4.3 SAVING A TREE FILE ........................................................................................................................ 10
  4.5 SAVING SEQUENCE INFORMATION FOR SABLE ................................................................................. 10
  4.6 CLOSING A TREE FILE ...................................................................................................................... 10
  4.7 ENVIRONMENT OPTIONS .................................................................................................................... 11
  4.8 CHANGING THE PAGE SETUP FOR PRINTING .................................................................................... 13
  4.9 VIEWING A PRINT PREVIEW .............................................................................................................. 14
  4.10 PRINTING THE TREE ....................................................................................................................... 15
  4.11 EXITING GAETR ............................................................................................................................... 15

5 GENERAL EDITING COMMANDS ......................................................................................................... 16
  5.1 CUTTING .......................................................................................................................................... 16
  5.2 COPYING ......................................................................................................................................... 16
  5.3 PASTING .......................................................................................................................................... 17
  5.4 DELETE ........................................................................................................................................... 17

6 WORKING WITH TREES ....................................................................................................................... 18
  6.1 CREATING A NEW TREE .................................................................................................................... 18
  6.2 DELETING A TREE ............................................................................................................................. 18
  6.3 JUMPING TO A TREE .......................................................................................................................... 19
  6.4 RENAMING A TREE ............................................................................................................................ 19
  6.5 ADDING A NEW NOTE ........................................................................................................................ 19
  6.6 EDITING AN EXISTING NOTE ........................................................................................................... 20

7 EDITING BRANCHES ............................................................................................................................ 21
  7.1 ADDING A NEW QUESTION ................................................................................................................. 21
DISCLAIMER

Portions of this document may be illegible in electronic image products. Images are produced from the best available original document.
Acknowledgments

A number of people at Sandia National Laboratories made significant contributions to this document. Dena Bertolino tested the GAETR code and improved the documentation; Julie Gregory, Tom Brown, Greg Wyss, and Donnie Whitehead continually tested the code and made suggestions for improving it. Dave Carlson and Kevin Maloney of Sandia’s Assessment Technologies Department and Allen Camp of Sandia’s Risk Assessment and Systems Modeling Department provided technical and managerial support for this project. Ruth Haas of TechReps did the technical editing for this manual. I am grateful for the help I received from all of these colleagues.

I would also like to acknowledge the work done by L. Abeyta and B. Lopez of Science and Engineering Associates in the draft SANET version 2.0 users’ manual.
1 Introduction

GAETR (Graphical Analysis of Event Trees) is a Microsoft® Windows™ 95/NT application for graphically creating event trees. GAETR supports two output modes: printing on any Windows-supported printer and copy/paste from the Windows clipboard. With these two output modes, you can create publication-quality graphics.

GAETR can be used as a stand-alone code for creating event trees or as a module in the ARRAMIS™ risk and reliability code suite. With ARRAMIS™ (of which GAETR is one module), you can perform a complete risk assessment, including fault tree creation and solution, event tree creation and solution, stratified data sampling, and state-of-the-art importance analysis.

Using GAETR, you can:

- Graphically build event trees on the screen
- Create multiple branches at each point
- Assign probabilities to each branch; the cumulative probabilities for each path through the tree are displayed at the end of each path
- Describe each tree with a variety of headers and labels.

Additional features and upgrades from the SAN;ET 1.0 code include:

- Porting from a DOS environment to a 32-bit Microsoft® Windows™ 95/NT environment
- Capability for multiple branches at each node
- Common Windows formatting techniques for branches, questions, notes, and table cells
- Moveable notes in the tree, as well as nonprintable notes associated with each branch
- Print preview through Windows
- Expansion to a multiple document interface, with the ability to display multiple trees at the same time
- Ability to store multiple trees in a single file
- Output sequence logic files for input to SABLE (Sandia Automated Boolean Logic Evaluation)
- Importing the tree into other applications (such as Microsoft Word or Microsoft PowerPoint) through the Windows Clipboard as a metafile
- Scrolling and sizing views of event trees
- Importing SANET 1.0 trees
- Importing binned and rebinned SETAC (Sandia Event Tree Analysis Code) output and event tree logic files used as input for the EVNTRA code.
2 Installation Instructions

2.1 Machine Requirements

To install GAETR, verify that your computer meets the following minimum hardware and software requirements:

- A 486/66 IBM-compatible PC or higher (a Pentium 133 is recommended)
- 8 MB RAM memory (32 MB RAM is recommended)
- Microsoft Windows 95 or Windows NT
- Windows 95/NT-supported monitor (VGA required, SVGA or better recommended)
- Mouse
- 1.4-MB 3.5-inch disk drive
- Hard disk with at least 2 MB free

2.2 Installing GAETR

To install GAETR:

1. Run Windows 95/NT.

2. Put the GAETR install disk in Drive A or Drive B.

3. Using the Start button, choose the “Run” command. Type

   a:\setup
   or
   b:\setup

   from the Command line edit box and choose “OK.” This will start the GAETR setup program.

4. The screen will ask you where you want to install GAETR. By default, all programs in the ARRAMIS™ risk and reliability code suite will be installed in “C:\ARRAMIS.” You may change this directory; however, you must install each of the ARRAMIS™ modules in the same directory.
2.3 Troubleshooting

In case of problems, please contact:

Risk Assessment and Systems Modeling Department
Organization 6412, MS 0747
PO Box 5800
Sandia National Laboratories
Albuquerque, NM 87185

Phone: (505) 844 - 0056
Fax: (505) 844 - 3321
e-mail: arramis@sandia.gov
3 Overview of GAETR

GAETR is a multiple document interface (MDI) application; it consists of a main screen and application (child) windows for trees. Once GAETR begins, the main screen appears (shown in Figure 3-1) with an empty tree window.

3.1 The Main Screen in GAETR

The GAETR main application window is shown below. Child windows (called tree windows) that represent event tree files are located in the application workspace. While each window generally represents a different event tree file, it is possible to open several windows on the same data for any file.

Figure 3-1: GAETR Main Window
3.1.1 GAETR Toolbar

The GAETR Toolbar, which is immediately below the Menu Bar in Figure 3-1, contains buttons and a task bar to manage files and the tree in the active window. The first group of buttons are standard Microsoft toolbar options for file handling, including New, Open, Save, Close and Print. The second group allows the user to add new trees to the current file and new notes to the current tree. The first two sections in the toolbar act as regular buttons. The third section of buttons in the toolbar acts as task definitions, allowing the user to Add, Cut, Copy, Paste, and Pass. To perform the selected task, double click on an item. For example, if you press the “Add” task and then double click on a branch, you will add a branch. By clicking once on any item in the tree, no matter which task is selected, you will select that item (as identified by the focus rectangle). If a button operation cannot be performed due to the current selection or file, the button will beep when selected.

The scale spin controls let you scale the current tree for easier viewing.

The last button is a shortcut that allows you to jump to another tree. Pressing this button will take you to the next tree in the tree file. To go to a specific tree, select “Tree | Go To” from the menu, which will display an alphabetized list of trees in the current file.

3.1.2 Edit Bar

The Edit Bar allows you to enter information about the branches, table cells, title cells, and questions. The Edit Bar will change with the window selection.

When you select a branch, the Edit Bar allows you to edit the branch label, probability, and a nonprintable note. The nonprintable note allows you to retain information about the branch. Pressing the ellipse button (…) to the right displays a dialog box, allowing you to edit the note. The state of the Edit Bar after a branch is selected is shown in Figure 3-2.

![Figure 3-2: Branch Edit Bar](image)

When you select a table cell, the Edit Bar will show a label containing the title of the currently selected column and one edit field, Path <n> Data, where <n> is the number of the selected path. The state of the Edit Bar when a table is selected is shown in Figure 3-3. Note that the path number or probability cannot be edited.
If a cell in the title section of the tables is selected on the Tree Window, the Edit Bar contains one edit field, the title. The state of the Edit Bar when a title is selected is shown in Figure 3-4.

![Figure 3-3: Table Edit Bar](image)

When you select a question, the Edit Bar allows you to edit the question and SABLE text (see Appendix A for information on SABLE text). The state of the Edit Bar when a question is selected is shown in Figure 3-5.

![Figure 3-4: Title Edit Bar](image)

While the Edit Bar is being used, the two buttons at the left edge of the bar are activated. The "X" button is used to cancel and the checkmark button indicates that the selection is OK. Cancel will restore the fields to the state they were in before the edit mode was entered. Pressing OK (or hitting "Enter") will save the changes that were made. Keyboard focus is moved from one Edit Bar control to the next in the edit mode via the "Tab" key.

![Figure 3-5: Question Edit Bar](image)

3.1.3 Status Bar

The Status Bar at the bottom of the GAETR main window shows messages that explain what the program is doing. The current branch and question are displayed on the Status Bar at the far right.

3.1.4 GAETR Menus

GAETR contains Windows-standard menus for file handling, editing, and window functions, as well as specialized menus for building, formatting, and viewing trees. The functions performed by each menu item in the GAETR menu bar are described in the following chapters. Each menu item contains an accelerator key that allows the user to select a menu item with the keyboard instead of the mouse. An underscore indicates the
keystrokes needed to execute the keyboard shortcut. For instance, “File | New” is invoked with the key sequence Alt-F N.

3.2 Tree Windows

A Tree Window is created for each “File | New” and each successful “File | Open” (or by pressing the corresponding button in the tool bar). The tree window title bar contains the name of the tree file and the name of the current tree. Figure 3-1 shows two windows, one of which is minimized. Several tree files can be opened at the same time. Several windows can be created for the same data to allow the user to view different parts of the same tree simultaneously.

3.2.1 Questions

An event that might occur at a particular branch level is described by Questions. The first question is initialized to "Initiating Event" for a new Tree Window. Question headers are located at the top of the tree window. The SABLE header is displayed below the question header and is used to create a Boolean expression that describes each path through the tree. Names of up to 16 characters can be entered for SABLE; they may contain any combination of letters, numbers, an underscore, a dash, a colon, and/or a backwards slash. GAETR will check for incorrect names and automatically change the characters to upper case. See Appendix A for a detailed explanation of SABLE text and sequence information.

3.2.2 Branches

A straight horizontal line indicates a branch. You can add branches for any visible question except the first one (the initiating event). A label is displayed above the branch line, and the probability for the branch is shown above or below the line. A cumulative probability can appear next to the probability in your configuration.

3.2.3 Tables

The probability table, outcome table, description table, and path numbers appear in the Tree Window to the right of the actual tree. You can make an entry in tables by selecting a path in the chosen table and then entering data in the edit fields on the Edit Bar.

You can configure the table titles on the Edit Bar only if a title cell is selected. The data in the probability table are calculated from the probabilities on the branches and cannot be edited.
The Tree Window displays the path numbers after the last branch in a path. GAETR generates path numbers in ascending order, starting with the highest path. If the path number is followed by the letter “T,” the selected branch transfers to another tree (see Section 7.6).

3.2.4 Notes

Notes can be linked to a particular branch or can appear anywhere in the Tree Window. To link a note to a branch, select the branch and enter the text of the notes in the Edit Bar along with the branch label and probability. The note associated with a branch is not displayed on the tree; it is provided so the user can keep nonprintable information about the branch. A button that indicates an ellipsis follows the Note field on the Edit Bar. Clicking this button brings up a dialog box that allows you to view and edit the full note. You can also select “Tree | New Note” to create a note on the tree that can be moved and sized to fit; these notes in the tree area are printed with the tree. An existing note can be edited by selecting the note and then selecting “Tree | Edit Note” from the menu.

3.2.5 Current Selection

A gray, dotted rectangle (focus rectangle) marks the current selection on the Tree Window and identifies the selection to be affected by the next action. If a question is selected, for example, a new question is added after the selected question through New Question on the Branch menu.

3.2.6 Pop-Up Menus

Pop-up menus have been provided in GAETR for your convenience. Pressing the right-hand mouse button after selecting an item will show a menu related to that selection. For example, if you select a branch and then press the right-hand mouse button, the following menu will appear.

- Add
- Cut
- Copy
- Paste
- Pass
- Delete
- Format...
- Collapse
- Transfer...
- Remove Transfer
4 File Handling

GAETR saves two kinds of files: event tree (*.ETR) files and SABLE (*.SEV) sequence files. Event tree files are the native GAETR files, which store tree information in binary format. More than one tree can exist in a tree file. SABLE sequence files output information in a SABLE format; they contain Boolean equations for each path through an event tree. Appendix A contains a detailed explanation of the SABLE sequence output files.

Files created by SANET 1.0 can be read by this version. In addition, GAETR can read binned SETAC output (file extension *.EBP), rebinned SETAC output (file extension *.PBP), and event tree logic files produced for EVNTRE (file extension *.ETI). GAETR cannot read the SETAC files if their files extensions have been changed.

The GAETR file functions, including storage, retrieval and printing functions, are contained in the File menu. The GAETR toolbar contains buttons for New, Open, Save, Close, and Print, which perform the same functions as their File menu counterparts.

4.1 Creating a New File

To create a new Tree Window, choose “File | New.” A new Tree Window named “TreeFile<N>-Tree <M>” is created where <N> is the number of new files created and <M> is the number of new trees. The event tree is initialized, with the first Question indicating “Initiating Event,” and one branch is drawn that has a probability of 1.0.

4.2 Opening a Tree File

Open brings up a Windows standard Open dialog box initialized to browse for native GAETR files (*.ETR) or SETAC-related files (*.ETI, *.PBP, and *.EBP).

To open an existing Tree file:

1. Choose “File | Open” to display the Open dialog box.

2. Select a file from the list on the left side of the dialog box. To change directories and browse for any new Tree files, use the list box on the right side of the dialog box.

3. Choose “OK.” A new Tree Window will appear that contains the information from the Tree file selected.
4.3 Saving a Tree File

“File | Save” will save the contents of the active Tree Window to disk using its current pathname. If the window has already been saved and named, the contents will be written to the previously named file. If the file has not been named, a Windows dialog will appear to allow you to select the name and path of the file to save.

The contents of the active Tree Window can be saved under a new Tree file name by using “File | Save As.” Enter the name of a file and choose a directory for saving the data in the active Tree Window.

You cannot change the logic of a SETAC-related file, and you cannot save any formatting changes to that file — each type of the SETAC-related files is read-only. However, you may save the tree information to a native GAETR file (*.ETR) to preserve formatting by using “File | Save As.”

4.5 Saving Sequence Information for SABLE

To save the contents of the active Tree Window to a SABLE file, choose “File | Save SABLE.” A dialog box will be displayed from which you can save the current tree. You must save the file with an extension “*.SEV.”

If the current tree is not a native GAETR file, you will be informed that the current tree cannot be saved to a SABLE file. Also, since sequence information is based on success/failure states (binary outcome to questions), you cannot save the sequence information from a tree that has more than two branches at any question.

4.6 Closing a Tree File

To close the active Tree Window, choose “File | Close.” You may also click the “X” button in the upper right-hand corner of the tree window to close the file. If the active Tree Window have not been saved, you will be asked if you want to save the Tree Window.
4.7 Environment Options

“File | Options” leads to a dialog box that contains controls for customizing GAETR. You can specify how you want to save the event tree file and the GAETR configuration file.

To indicate user preferences:

1. Choose “File | Options” to display the Options dialog box, shown in Figure 4-1.

![Figure 4-1: Options Dialog Box](image)

2. If you want GAETR to create a backup copy of a tree file as it existed when you opened the file, select “Always Create Backup.” The backup copy will have the same name as the tree file, but will also have the extension *.BAK. GAETR will store the backup copy in the same directory as the original file.

3. If you would like GAETR to automatically save all open Tree Windows every <N> minutes, select “Automatic Save Every <N> Min.” Enter a number in the field provided. This option saves the actual tree file, not the backup file.
4. Select a default directory by double clicking on the desired directory in the list. The default directory is the starting position for all file searches when calling a common dialog for opening and saving files.

5. Select “Save Options in GAETR.INI File” if you want these options to be saved in the initialization file. If you do not save these options, you will have to reset them each time you invoke GAETR.

6. Choose “OK.”
4.8 Changing the Page Setup for Printing

The Page Setup feature allows the user to select printing orientation, page number position, header text, printing borders, margins, and scaling options. The following is the default format: page numbers on the center bottom of each page, no header text, a top and bottom border (a separator line on the top and bottom of each printed page), all margins 1 inch, and instructions to scale a tree to fit on one page. If you do not select “Scale Tree to Fit On One Page,” the tree is scaled solely by the horizontal and vertical scaling options on the main window (see chapter 8). Note: Trees will print approximately four times faster if they are scaled to fit on one page.

![Page Setup Screen](image)

**Figure 4-2:** Page Setup Screen
4.9 Viewing a Print Preview

The Print Preview menu item provides a WYSIWYG (what you see is what you get) print preview, page by page. The Print Preview screen is shown in Figure 4-3. Buttons with arrows at the top of the page allow you to move forward and backward in one-page increments. The print button will print the current page as shown on your Windows default printer. Also, the zoom combo box allows different sizes to be chosen. To return to the GAETR tree environment, press “Close.”

![Print Preview Screen](image)

**Figure 4-3:** Print Preview Screen
4.10 Printing the Tree

Print brings up a Microsoft Windows standard Print dialog box that allows you to print the tree in the active Tree Window.

4.11 Exiting GAETR

Exit closes all open Tree Windows, permitting you to save any changes you may have made, then terminates the application. To exit GAETR, choose “File | Exit.” You may also click the “X” button in the upper right-hand corner of the main GAETR window.
5 General Editing Commands

The Edit menu contains standard editing options, such as Cut, Copy, Paste, and Delete. There are Edit commands for branches, questions, notes, and the Outcome and Description table cells. The level of operation for branches is the subtree (the branch and all structures to the right of the branch) rather than just a selected branch. Note that these operations cannot be performed on imported SETAC files (*.PBP, *.EBP, and *.ETI).

5.1 Cutting

Cut removes a branch and all children and places the subtree into the GAETR clipboard. If the branch selected is connected to other branches, the probabilities are reset to $1/n$ with $n$ being the number of branches remaining after the cut. Note: The last branch cannot be cut. When a question is selected, Cut removes the question and places it into the GAETR clipboard.

There are four ways to use the Cut operation. To cut a branch or question, you may either 1) select the branch or question with the mouse, right click the mouse which will show the branch or question pop-up menu, and select Cut from it, 2) select the branch or question with the mouse and select “Edit | Cut” from the GAETR menu, 3) select the branch or question with the mouse and press Ctrl+X on the keyboard (the accelerator key for the “Edit | Cut” menu item), or 4) press the “Cut” button on the GAETR task bar and double click the branch or question you wish to cut. Each of these operations will cut the branch or question and place the object in the clipboard.

5.2 Copying

When a branch is selected, Copy copies the selected branch and all the developed structure to the right of the branch, including the labels and table entries (except the probability table) into the GAETR clipboard. Copy will also copy a selected Question Header or Table entry.

There are four ways to use the Copy operation. To copy a branch, question, or table entry, you may either 1) select the object with the mouse, right click the mouse which will show the appropriate pop-up menu, and select Copy from it, 2) select the object with the mouse and select “Edit | Copy” from the GAETR menu, 3) select the branch or question with the mouse and press Ctrl+C on the keyboard (the accelerator key for the “Edit | Copy” menu item), or 4) press the “Copy” button on the GAETR task bar and double click the object you wish to copy. Each of these operations will copy the object and place it in the clipboard.
Note: The Copy option will also copy the entire tree and place it as a metafile onto the Windows clipboard. It may then be pasted into other packages, such as Microsoft PowerPoint.

5.3 Pasting

“Edit | Paste” places the branch, question, or table entry from the GAETR clipboard at the selection currently highlighted. Note: Only a branch that has no children can be pasted on.

There are four ways to use the Paste operation. To paste a branch, question, or table entry, you may either 1) select the destination location with the mouse, right click the mouse which will show the appropriate pop-up menu, and select Paste from it, 2) select the destination location with the mouse and select “Edit | Paste” from the GAETR menu, 3) select the branch or question with the mouse and press Ctrl+V on the keyboard (the accelerator key for the “Edit | Paste” menu item), or 4) press the “Paste” button on the GAETR task bar and double click the destination location. Each of these operations will paste the object from the clipboard to the desired location.

5.4 Delete

Questions, branches, and notes are removed with Delete. You may not delete a question if it contains developed branches under it. If a branch is deleted, all developed structures to the right of the branch are deleted as well. If the branch is connected to other branches, the probabilities are reset to $1/\langle n \rangle$, with $\langle n \rangle$ being the number of branches remaining after the deletion. Note: You cannot delete the last branch.

There are two ways to use the Delete operation. To delete a branch, question, or note, you may either 1) select the object with the mouse and right click the mouse which will show the appropriate pop-up menu, and select Delete from it, or 2) select the object with the mouse, select “Edit | Delete” from the GAETR menu. Each of these operations will delete the object.
6 Working with Trees

Functions for tree management are contained in the Tree menu. They include creating, deleting, and renaming a tree within the currently open event tree file (*.ETR), and creating and editing notes on the current tree.

6.1 Creating a New Tree

A dialog box in New allows you to enter a name for a new tree to be added to the event tree file (*.ETR file) that is in the active Tree Window.

To create a new tree, Choose “Tree | New” to display the Tree Name dialog box, shown in Figure 6-1. The Name edit field is initialized to Tree <N> where <N> is the count of new trees created for the current session.

![Figure 6-1: Tree Name Dialog Box](image)

Change the name if you wish; duplicate tree names are allowed. Choosing “OK” will clear the contents of the active tree window, and a new, empty tree will be shown.

6.2 Deleting a Tree

You can delete the selected tree from the event tree file in the active tree window by using Delete. To delete a tree, select “Tree | Delete” from the menu. The screen will warn you that the entire tree will be deleted and will give you the opportunity to cancel the action. Note: you cannot delete the last tree from a file.
6.3 Jumping to a Tree

To select and display a tree in the current tree file, choose “Tree | Go To” to display the Trees dialog box, shown in Figure 6-2. The trees are listed in alphabetical order.

![Figure 6-2: Trees Dialog Box](image)

Select the tree you wish to display from the list of trees. Choosing “OK” (or double clicking on the tree) will display the tree in the active tree window.

6.4 Renaming a Tree

To rename a tree, choose “Tree | Rename” to display the Tree Name dialog box (shown in Figure 6-1). The box will appear initialized to the name of the selected tree. Modify the name. Duplicate tree names are allowed. Choosing “OK” will change the name, which is updated in the event tree file and on the tree window title bar.

6.5 Adding a New Note

To enter a new note, Choose “Tree | New Note” to display the Edit Note dialog box, shown in Figure 6-3.

Notes can be added anywhere in the tree application area. When notes are added with “Tree | New Note” (as opposed to the Notes option on the branch Edit Bar, see Section 3.1.2), they are printed with the tree.
Enter the text of the note in the edit field. Choosing “OK” (or pressing “Enter”) will save the note; the new note will appear in the top left corner of the tree window. You can select the note and drag it to another location if you wish.

6.6 Editing an Existing Note

“Tree | Edit Note” allows you to edit an existing note. Select the note to be edited. Choose “Tree | Edit Note” to display the Edit Note dialog box. Change the note as you wish. Choosing “OK” (or pressing “Enter”) will save the changes to the note text. The existing note will be updated on the tree window.
7 Editing Branches

The functions for managing the branches of the active tree window are contained in the Branch menu.

7.1 Adding a New Question

There are four ways to add a new question. To add a question, you may either 1) select a question with the mouse, right click the mouse which will show the question pop-up menu, and select Add from it, 2) select a question with the mouse and select “Branch | New Question” from the GAETR menu, 3) select the question with the mouse and press Ctrl+Q on the keyboard (the accelerator key for the “Branch | New Question” menu item), or 4) press the “Add” button on the GAETR task bar and double click a question.

Each of these operations will insert a new question onto the tree after the question selected, and it becomes the new selection. To edit the text of the question, select the question and use the Edit Bar.

7.2 Adding a New Branch

Branches can be added for any visible question but cannot be added to the initiating event. The new branch and its connected branches will have probabilities set to $1/\langle n \rangle$, with $\langle n \rangle$ being the number of branches connected at that point. Once the branch is selected, these probabilities can be edited in the Edit Bar.

There are four ways to add a new branch. To add a branch, you may either 1) select a branch with the mouse, right click the mouse which will show the branch pop-up menu, and select Add from it, 2) select a branch with the mouse and select “Branch | New Branch” from the GAETR menu, 3) select the branch with the mouse and press Ctrl+B on the keyboard (the accelerator key for the “Branch | New Branch” menu item), or 4) press the “Add” button on the GAETR task bar and double click a branch.

The new branch will be added as a sibling to the selected branch. The selection point is important. If you select above the branch, a sibling will be added above the branch. If you select below the branch, a sibling will be added below the branch.
7.3 Passing a Branch

The process for Pass Branch is similar to that for deleting a branch (see section 5.4) except that the highlighted structure is reduced to a single branch that passes through from the left side of the highlighted area to the end of the tree.

There are three ways to pass a branch. To pass a branch, you may either 1) select a branch with the mouse, right click the mouse which will show the branch pop-up menu, and select Pass from it, 2) select a branch with the mouse and select “Branch | Pass Branch” from the GAETR menu, or 3) press the “Pass” button on the GAETR task bar and double click a branch.

This branch and its children will be removed and replaced by a straight line.

7.4 Expanding a Collapsed Branch

Since a branch should always pass through to the end of the tree, if it does not go to the end of the tree, the branch has been compressed and can be expanded by using Expand. This causes a selected branch to “open” and show all its child branches.

There are two ways to expand a collapsed branch. To expand a branch, you may either 1) select the collapsed branch with the mouse, right click the mouse which will show the branch pop-up menu, and select Expand from it, or 2) select a branch with the mouse and select “Branch | Expand” from the GAETR menu.

7.5 Collapsing a Branch

Using Collapse will cause a selected branch to “close” and collapse (or hide) all child branches. If the selected branch has no children, it is truncated.

There are two ways to collapse a branch. To collapse a branch, you may either 1) select a branch with the mouse, right click the mouse which will show the branch pop-up menu, and select Collapse from it, or 2) select a branch with the mouse and select “Branch | Collapse” from the GAETR menu.

Each of these operations will collapse the branch, and the collapsed branch remains selected.

7.6 Transferring a Branch to Another Tree

You can transfer a selected branch to another tree by using Transfer. A dialog box contains Edit boxes for entering the name of the tree to which the branch is being
transferred and the name of the file that contains the tree. If the selected branch is not a
transfer, the file name will be the name of the current file. If the selected branch is a
transfer, the file name and tree name will provide the transfer information. The branch
cannot have children.

To transfer a branch to another tree:

1. Select a branch.

2. Either choose “Branch | Transfer” from the GAETR menu or right click the mouse
and select “Transfer” from the branch pop-up menu to display the Transfer dialog
box, shown in Figure 7-1.

3. Press the “File” button for a standard Microsoft Windows browse dialog to select the
file that contains the tree you want to transfer to.

4. Use the arrow on the “Tree Name” combo box to see a list of trees in the specified file
and select the tree that will receive the transfer. You may also type in the name of the
tree; if the tree does not exist, GAETR will create it for you.

5. If you would like to move immediately to the transfer location, select “Go To
Transfer.” The transfer tree will be displayed in a new window.

6. When you choose “OK,” the selected branch will be transferred to the specified tree
in the specified file.

7.7 Removing a Transfer

There are two ways to remove a transfer from a branch. Select the branch that contains
the transfer to be removed and either choose “Branch | Remove Transfer” from the
GAETR menu or right click the mouse to show the branch pop-up menu and select
Remove Transfer. The transfer will be removed from the selected branch. If the branch selected does not contain a transfer, this menu item will not be available.
8 Viewing Options

The following View menu functions control display in the active Tree Window:

- **View**
  - Always Fit to Window
  - Fit to Window
  - Horizontal Scale Up
  - Horizontal Scale Down
  - Vertical Scale Up
  - Vertical Scale Down
  - Show Grid

The first six items are used to set the display scale of the Tree Window. Always Fit to Window can be set so that the tree is always fitted to the window. The user can fit a current tree to the window by reducing or enlarging its display size. The toolbar spin controls can also be used to change the horizontal or vertical scale by one step. There are dialog boxes for these items. To perform the desired action, select the item from the View menu.

“View | Show Grid” displays a grid on the current Tree Window. If the grid is already shown in the window, the label becomes “Hide Grid.” If the grid is not shown, the label is “Show Grid.” Select the menu item you desire. The grid spacing is set as separators between questions.
9 Formatting the Tree

You may format branches, question headers, notes, and table cells through the Format menu.

9.1 Formatting Branches

The Branch option provides a dialog box (shown in Figure 9-1) from which you can format the branch components. You can show or hide the branch label, probability, and cumulative probability. You can select the line color, width, and style for a branch. You can also select the format of the probability and cumulative probability, as well as the font attributes for the label and probabilities. A sample shows the branch label, probability, and line.

![Figure 9-1: Branch Format Screen](image)

The “Set as Default” button allows you to select the formats for branches that you will later create. Selecting “Set as Default” will not change the branches that you have already created. The default for the branches is also the format used to draw the connecting lines.
The “Apply To” box allows you to apply the new format to either the selected branch, all branches in the current tree, the selected branch and its children (its subtree), or the select branch and its parents. If you choose “Selected Branch and its Children”, the connecting lines in the subtree will be the same color, width, and style as the subtree branches. If you choose “Selected Branch and its Parents”, the full path, including the portion of the vertical connecting lines within the path back to the initiating event, will be formatted according to the selected line color, width, and style.
9.2 Formatting Headers (Questions)

You can format question headers from the Header dialog box and select the font attributes. You can also modify the header width by entering the width in inches in the edit field. The settings can be applied to the selected question or all questions. You may also display or hide the question text and/or SABLE text. Even if you do not display the question and/or SABLE text, you will still be able to modify and add text in the Edit Bar. Note: specifying "Selected Questions" only applies to the column width. All other modifications are made to all questions.

Figure 9-2: Header Format Screen
9.3 Formatting Notes

You can format notes from the dialog box in Note and select the font attributes to be applied to the note. Format options include displaying a border around the note and setting the note to be opaque. Setting the note to be opaque essentially puts the note ‘on top’, meaning that any structure under the note is not seen. The format choices can be applied to the selected note or all notes. Note: due to a limitation in the software used to write GAETR, you cannot have a dashed thick line. Only the thinnest line style will allow a segmented line.

![Note Format Screen]

**Figure 9-3:** Note Format Screen
9.4 Formatting Tables

You can format tables from the Table dialog box. You can modify the table row height by entering the new width (in inches) in the edit field. You can select the font attributes and the formatting code used to formatting the probability. Note: GAETR allows the user to format each row separately, but you cannot format a single cell separately.

![Table Format Screen](image)

**Figure 9-4:** Table Format Screen
10 Window Options in a Multiple-Document Interface

The following options are available under the Window menu. This is a standard Microsoft MDI Window menu.

<table>
<thead>
<tr>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Window</td>
</tr>
<tr>
<td>Cascade</td>
</tr>
<tr>
<td>Tile</td>
</tr>
<tr>
<td>Arrange Icons</td>
</tr>
<tr>
<td>Close All</td>
</tr>
</tbody>
</table>

FILE1.ETR-Tree Name
FILE2.ETR-Tree Name
etc...

The last group of menu items (FILE1.ETR-Tree Name, etc.) contains the names of the open Tree Windows. When you choose one of these Tree Windows, it activates the named window and brings it to the front.

10.1 Creating a New Window

"Window | New Window" creates a new view of the current tree in the active Tree Window.

10.2 Other Window Menu Items

Cascade, Tile, Arrange Icons, and Close All are standard MDI functions and act in the same way as their counterparts in File Manager and Program Manager.
11 Getting Help

The following options are available under the Help menu.

- Help
  - Contents
  - Commands
  - Procedures
  - Glossary
  - Search for Help On...
  - How to Use Help
  - About GAETR...

These functions use a Microsoft Help application that contains user documentation for GAETR.

The About GAETR menu item brings up a dialog box that shows information on the current version of the software.
Appendix A  Sequence Format for SABLE

GAETR generates event sequence information based on successes and failures through each path of an event tree. This sequence information is input to SABLE, the fault tree and accident sequence solution module used in the ARRAMIS™ code suite.

The sequence information consists of a success and failure expression for each path through the event tree. The failure expression (denoted by an “S” for “Sequence”, the path number, and “-F” for “Failure”) is generated by ANDing the initiating event with failures for that path. Thus, it represents the top gate of a fault tree that includes the initiating event and all systems that are known to have failed on the event sequence path being analyzed. The success expression (denoted by an “S” for “Sequence”, the path number, and “-S” for “Success”) is generated by ORing each success in the path. It physically represents the set of failure conditions that are known to have not occurred on the event sequence path being analyzed. SABLE uses these expressions by first constructing all of the cut sets for the failure expression, and then deleting all cut sets that are known to have not occurred because of the conditions found for the success condition. For more information on accident sequence analysis, see “A SETS User’s Manual for Accident Sequence Analysis.”

In all cases, GAETR assumes that the top branch represents success and the bottom branch represents failure. To save the sequence information, a SABLE header must be entered for all questions, including the initiating event.

For example, Figure A-1 shows an event tree using the SABLE header. For the first path, the failure expression contains only the initiating event T1. This same path contains three successes: RPS, DG, and ECCS. Thus, the failure expression for path one is “S1-F = T1” and the success expression for path one is “S1-S = RPS + DG + ECCS.” Path two contains one failure, ECCS, and two successes, RPS and DG. Thus, the failure expression for path two is “S2-F = T1 * ECCS” and the success expression for path two is “S2-S = RPS + DG.” The SABLE sequence file for this tree is shown in Figure A-2.

---

<table>
<thead>
<tr>
<th>Loss of normal AC power</th>
<th>RX Trip</th>
<th>Emergency AC power</th>
<th>Coolant injection</th>
<th>Path</th>
<th>Outcome</th>
</tr>
</thead>
<tbody>
<tr>
<td>T1</td>
<td>RPS</td>
<td>DG</td>
<td>ECCS</td>
<td>1</td>
<td>Success</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2</td>
<td>Core Melt</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3</td>
<td>Success</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4</td>
<td>Core Melt</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5</td>
<td>ATWS</td>
</tr>
</tbody>
</table>

**Figure A-1:** Test2 Tree

\[
\begin{align*}
S1-F &= T1. \\
S1-S &= RPS + DG + ECCS. \\
S2-F &= T1 * ECCS. \\
S2-S &= RPS + DG. \\
S3-F &= T1 * DG. \\
S3-S &= RPS + ECCS. \\
S4-F &= T1 * DG * ECCS. \\
S4-S &= RPS. \\
S5-F &= T1 * RPS. \\
S5-S &= \text{/OMEGA}. \\
\end{align*}
\]

**Figure A-2:** SABLE Sequence Logic for Test2 Tree
Appendix B  Event Tree Library

A number of event trees are provided in a library for your use. These trees are useful for learning and experimenting purposes, as well as for providing a starting point for your detailed event trees. These six event trees (shown in Figures B-1 to B-6), with Test2 Tree from Appendix A (shown in Figure A-1) were automatically loaded into the “GAETRSampleTrees” subdirectory under the directory that you selected at the time of installation. Simply open these files to call them up (see section 4.2). These figures were generated by copying them onto the clipboard (see section 5.2) and pasting them into this document. You should be able to readily reproduce them.

The first example tree (shown in Figure B-1), Binary Tree, is a simple six question tree involving equal probability binary branching under each question. The next three trees, Success Tree, Failure Tree, and ThreeBranch Tree (shown in Figures B-2, B-3, and B-4 respectively), are also simple formulations involving equal probability branching. The next tree (shown in Figure B-5), Test Tree, is more complex, involving branch text labels, text notes, and a transfer to the next tree, ATWS (shown in Figure B-6). TestTree and its transfer tree, ATWS, are set up in a manner typical of the way that nuclear reactor accident sequence event tree are formulated.

---

<table>
<thead>
<tr>
<th>Initiating Event</th>
<th>Question 1</th>
<th>Question 2</th>
<th>Question 3</th>
<th>Question 4</th>
<th>Question 5</th>
<th>Question 6</th>
<th>Path</th>
<th>Probability</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>3.00E-01</td>
<td>3.00E-01</td>
<td>3.00E-01</td>
<td>3.00E-01</td>
<td>3.00E-01</td>
<td>3.00E-01</td>
<td>Path 1</td>
<td>1.55E-02</td>
</tr>
<tr>
<td></td>
<td>3.00E-01</td>
<td>3.00E-01</td>
<td>3.00E-01</td>
<td>3.00E-01</td>
<td>3.00E-01</td>
<td>3.00E-01</td>
<td>Path 2</td>
<td>1.55E-02</td>
</tr>
<tr>
<td></td>
<td>3.00E-01</td>
<td>3.00E-01</td>
<td>3.00E-01</td>
<td>3.00E-01</td>
<td>3.00E-01</td>
<td>3.00E-01</td>
<td>Path 3</td>
<td>1.55E-02</td>
</tr>
<tr>
<td></td>
<td>3.00E-01</td>
<td>3.00E-01</td>
<td>3.00E-01</td>
<td>3.00E-01</td>
<td>3.00E-01</td>
<td>3.00E-01</td>
<td>Path 4</td>
<td>1.55E-02</td>
</tr>
<tr>
<td></td>
<td>3.00E-01</td>
<td>3.00E-01</td>
<td>3.00E-01</td>
<td>3.00E-01</td>
<td>3.00E-01</td>
<td>3.00E-01</td>
<td>Path 5</td>
<td>1.55E-02</td>
</tr>
</tbody>
</table>

*Figure B-1: Binary Tree*
<table>
<thead>
<tr>
<th>Initiating Event</th>
<th>Question 1</th>
<th>Question 1</th>
<th>Question 1</th>
<th>Question 1</th>
<th>Question 1</th>
<th>Question 1</th>
<th>Path</th>
<th>Probability</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1</td>
<td>5.00E-01</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2</td>
<td>2.50E-01</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3</td>
<td>1.25E-01</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4</td>
<td>6.25E-02</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5</td>
<td>3.13E-02</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>6</td>
<td>1.56E-02</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>7</td>
<td>1.56E-02</td>
</tr>
</tbody>
</table>

**Figure B-2: Success Tree**

<table>
<thead>
<tr>
<th>Initiating Event</th>
<th>Question 1</th>
<th>Question 2</th>
<th>Question 3</th>
<th>Question 4</th>
<th>Question 5</th>
<th>Question 6</th>
<th>Path</th>
<th>Probability</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1</td>
<td>1.56E-02</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2</td>
<td>1.56E-02</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3</td>
<td>3.13E-02</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4</td>
<td>6.25E-02</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5</td>
<td>1.25E-01</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>6</td>
<td>2.50E-01</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>7</td>
<td>5.00E-01</td>
</tr>
</tbody>
</table>

**Figure B-3: Failure Tree**
Figure B-4: Three Branch Tree
Figure B-5: Test Tree

Figure B-6: ATWS Tree
DISTRIBUTION:

MS0747  A. L. Camp, 6412
MS0747  D. B. Bertolino, 6412
MS0747  R. G. Cox, 6412
MS0747  V. J. Dandini, 6412
MS0747  S. L. Daniel, 6412
MS0747  J. A. Forester, 6412
MS0747  K. M. Hays, 6412 [50]
MS0747  D. B. Mitchell, 6412
MS0747  S. P. Nowlen, 6412
MS0747  R. E. Pepping, 6412
MS0747  B. D. Staple, 6412
MS0747  T. J. Tanaka, 6412
MS0747  K. Waters, 6412
MS0747  D. W. Whitehead, 6412
MS0747  G. D Wyss, 6412
MS0748  B. S. Altman, 6413
MS0748  A. S. Benjamin, 6413
MS0748  N. N. Brown, 6413
MS0748  T. D. Brown, 6413
MS0748  J. J. Gregory, 6413
MS0748  S. L. Humphreys, 6413
MS0748  L. Shyr, 6413
MS0845  S. E. Dingman, 2521
MS0405  D. Bennett, 12333
MS0405  M. P. Bohn, 12333
MS0405  R. Breeding, 12333
MS0405  D. Carlson, 12333
MS0405  N. Dhooge, 12333
MS0405  M. Dvorack, 12333
MS0405  M. Fuentes, 12333
MS0405  T. Jones, 12333
MS0405  S. Kalemba, 12333
MS0405  Y. Lin, 12333
MS0405  K. Maloney, 12333 [5]
MS0405  W. McCulloch, 12333
MS0405  K. Sobolik, 12333
MS0405  J. Tenney, 12333
MS0405  M. Young, 12333
MS9018  Central Technical Files, 8940-2
MS0899  Technical Library, 4916 [5]
MS0619  Review and Approval Desk, 12690
for DOE/OSTI [2]